Chapter 5

iPad Tips, Tricks, and Apps

iPad Button Basics:
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When you lock an iPad, nothing happens if you touch the screen, but music continues playing
and you can use the volume buttons.

Lock iPad: Press the Sleep/Wake button.
Unlock iPad: Press the Sleep/Wake button.
Turn iPad off: Press the Home button or the Sleep/Wake button, then drag the slider.

Turn iPad on: Hold down the Sleep/Wake button for a few seconds until the red slider appears,
then drag the onscreen slider. Hold down the Sleep/Wake button until the Apple logo appears. If
you don’t touch the screen for a minute or two, iPad locks automatically. You can change how
long it takes the screen to lock, or set a passcode to unlock iPad.

Home button

Home

The Home button lets you get back to the Home screen at any time. It also provides other
convenient shortcuts.

To display the multitasking bar to see recently used apps: double-click the Home Button or four-
finger swipe up on any screen.

To close open apps: Swipe up on the app icon. The app is added to the recents list again, the next
time you open it.

To display audio playback controls: Swipe up from the bottom of any screen.

To access audio playback controls when running an app: Swipe up from the bottom of the screen.
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To adjust the screen’s brightness: Swipe up from the bottom of any screen. Drag the brightness
slider.
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To lock the screen rotation: Slide the Side Switch down to mute notifications, alerts, and sound
effects. This switch doesn’t mute audio playback, such as music, podcasts, movies, and TV
shows. In Settings, go to General > Use Side Switch to, then tap Lock Rotation.

To mute notifications, alerts, and sound effects: Slide the Side Switch. This switch doesn’t
mute audio playback, such as music, podcasts, movies, and TV shows.

Using multitasking gestures

You can use multitasking gestures on iPad to find, reveal the multitasking bar, or switch to
another app.

To switch between open apps: Swipe left or right with four fingers.
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Reveal the multitasking bar: Swipe up with four or five fingers.
To close out of any app: Four finger pinch

Turn multitasking gestures on or off: In Settings, go to > General > Multitasking Gestures,
then tap On or Off.

To locate an app on your iPad: Pull down from any screen to reveal the Search bar.
Syncing with 1Tunes

Syncing with iTunes copies information from a computer to iPad, and vice versa. You can sync
by connecting iPad to your computer using the Dock Connector to USB Cable, or you can set up
iTunes to sync wirelessly using Wi-Fi. You can set iTunes to sync music, photos, video, podcasts,
apps, and more. For detailed information about syncing iPad with a computer, open iTunes then
select iTunes Help from the Help menu.

Set up wireless iTunes syncing: Connect your iPad to your computer using the Dock Connector
to USB Cable. In iTunes, turn on “Sync over Wi-Fi connection” in the device’s Summary pane.
When Wi-Fi syncing is turned on, iPad automatically syncs every day. iPad must be connected to
a power source, both iPad and your computer must be on the same wireless network, and iTunes
must be open on the computer.

Tips for syncing with iTunes

If you’re using iCloud to store your contacts, calendars, bookmarks, and notes, don’t also sync
them to iPad using iTunes.

Purchases you make from the iTunes Store or the App Store on iPad are synced back to your
iTunes library. You can also purchase or download content and apps from the iTunes Store on
your computer, and then sync them to iPad.

Customizing the Home screen

You can customize the layout of app icons on the Home screen—including the icons in
the Dock along the bottom of the screen. You can create additional Home screens and arrange
your apps over multiple Home screens.

To rearrange icons: touch and hold any app on the Home screen until it jiggles. Arrange the
apps by dragging them. Press the Home button to save your arrangement.

To move an icon to another screen: While arranging icons, drag an icon to the right edge of the
screen until a new screen appears. You can return to a previous screen and drag more icons to the
new screen.

To create additional Home screens: While arranging icons, swipe to the rightmost Home
screen, then drag an icon to the right edge of the screen. You can create up to 15 Home screens.
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The dots above the Dock show the number of screens you have, and which screen you’re
viewing.

To go to a different Home screen: Flick left or right, or tap to the left or right of the row of
dots.

To go to the first Home screen Press the Home button.

To reset the Home screen to its original layout: In Settings, go to General > Reset, then tap
Reset Home Screen Layout. Resetting the Home screen removes any folders you’ve created and
applies the default wallpaper to your Home screen.

Organizing with folders

You can use folders to organize icons on the Home screen. You can put up to 135 apps in a
folder. iPad automatically names a folder when you create it, based on the icons you use to create
the folder, but you can change the name. Rearrange folders by dragging them on the Home
screen or by moving them to a new Home screen or to the Dock.

To create a folder: Touch and hold an icon until the Home screen icons begin to jiggle, then
drag the icon onto another icon. iPad creates a new folder that includes the two icons, and shows
the folder’s name. You can tap the name field to enter a different name.

To add an icon to a folder: When the icons are jiggling, drag the icon onto the folder.

To remove an icon from a folder: While arranging icons, tap to open the folder, then drag the
icon out of the folder.

To open a folder: Tap the folder. You can then tap an app icon to open that app.
To close a folder: Tap outside the folder, or press the Home button.

To delete a folder: Remove all icons from the folder. The folder is deleted automatically when
empty.

To rename a folder: While arranging icons, tap to open the folder, then tap the name at the top
and use the keyboard to enter a new name.

Changing the wallpaper

You can choose the images you want to use as wallpaper for your Lock screen and your Home
screen. Choose an image that came with iPad or a photo from your Camera Roll.

1. In Settings, go to Brightness & Wallpaper, tap the image of the Lock and Home screens,
then tap Wallpaper or Saved Photos.

Chapter 5 « 1Pad Tips, Tricks, & Apps * page 86



2. Tap to choose an image or photo. If you choose a photo, drag or pinch it to position or
resize it, until it looks the way you want. Tap Set Lock Screen, Set Home Screen, or Set
Both.

Editing text

To position the insertion point: Touch and hold to bring up the magnifying glass, then drag to
position the insertion point.

To Select text: Tap the insertion point to display the selection buttons. Tap Select to select the
adjacent word, or tap Select All to select all text. You can also double-tap a word to select it.
Drag the grab points to select more or less text. In read-only documents, such as webpages, or
messages you receive, touch and hold to select a word.

To cut or copy text: Select text, then tap Cut or Copy.

To Paste text: Tap the insertion point, then tap Paste to insert the last text that you cut or copied.
Or, select text, then tap Paste to replace the text.

To undo the last edit: Shake iPad.

Speed up text entry with these keyboard tricks
Skip the period: When you get to the end of a sentence, press the spacebar twice to insert a
period and a single space.

Faster apostrophes: Instead of switching to the number-punctuation keyboard, just swipe up on
the comma key to insert an apostrophe.

Faster quotes: Swiping up on the period/question mark key inserts double quotes.

Simple insertion of special keys: Press and hold various other letters on the keyboard to access
such characters as the French soft ¢ (as in"gargon"), the Spanish tilde n (as in "mafiana"), and the
umlaut i (as in "naive").

Broaden your punctuation horizons: You'll find a wider selection of punctuation marks by
using the same technique on the number-punctuation keyboard. For example, insert an upside-
down exclamation or question mark by swiping up (or pressing and holding) those respective
keys. Add ellipses by swiping up on the period key (only in the number-punctuation layout).
Insert various monetary symbols by pressing and holding the dollar sign, or swipe up on the zero
key to add a degree symbol. Perhaps my favorite of these shortcuts is the ability to add an em-
dash by swiping up on the hyphen key.

Activate--or disable--Caps lock: Tap either Shift key twice to type in all caps. If you want to
avoid accidentally switching to all-caps mode, deactivate the feature by opening Settings,
choosing Keyboard in the General category, and switching Enable Caps Lock to OFF.
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Other options on this screen let you disable (or enable) auto- capitalization, auto- correction,
spell check, and the period shortcut. You can also choose from several dozen international
keyboard layouts.

Using AirPlay to Broadcast your iPad screen

You can stream music, photos, and video wirelessly to an HDTV or speakers using AirPlay and
Apple TV. Your iPad and the the Apple TV must be on the same Wi-Fi network.

To Stream content to an AirPlay-enabled device: Start the video, slideshow, or music, then tap
[al and choose the AirPlay device. Once streaming starts, you can exit the app that’s playing the
content.

To quickly access the AirPlay controls: Swipe up from the bottom of any screen or app.
To switch playback back to iPad: Tap [&l and choose iPad.

You can mirror the iPad screen (iPad 2 or later) on a TV with Apple TV. Everything on the iPad
screen appears on the TV (Great for watching the New Patriots on NFL.com).

To mirror the iPad screen on a TV: Tap [4l at the left end of the multitasking bar, choose Apple
TV, and tap the Mirroring button that appears. A blue bar appears at the top of the iPad screen
when AirPlay mirroring is turned on.

Find My iPad

Find My iPad (download from the App Store) can help you locate a lost, stolen,or misplaced iPad
using an iPhone, iPod touch, or another iPad. You can also use Find My iPad using a Mac or PC
with a web browser signed in to www.icloud.com. Find My iPad uses Wi-Fi to locate your iPad.
If Wi-Fi is turned off or if your iPad isn’t connected to a Wi-Fi network, Find My iPad can’t find
1t.

Viewing a Google Earth Tour

The new version of Google Earth for the iPad can read KMZ/KML tour files. Create the tour in
Google Earth on your laptop or download a file from the Google Earth Gallery or a file you
found through Google Advanced Search, and then save the file in Dropbox or email it to
yourself. Switch to the iPad, find the file, and choose “Open in Google Earth.”
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Taking photos and videos

To take a photo: Make sure the Camera/Video switch is set to @, then aim and tap @', You can
also take a photo by pressing the Volume Up button.

To record a video: Slide the Camera/Video switch to m «, then tap ' ® ' to start or stop recording,
or press the Volume Up button.

When you take a photo or start a video recording, iPad makes a shutter sound. You can control
the volume with the Volume buttons or the Side Switch. A rectangle briefly appears where the
camera is focused and setting the exposure. When you photograph people, iPad (3rd generation)
uses face detection to automatically focus on and balance the exposure across up to 10 faces. A
rectangle appears over each detected face.

To zoom in or out Pinch the screen (back camera, in camera mode only).
To turn on the grid: Tap Options.
To set the exposure Tap the person or object on the screen.

To lock the exposure Touch and hold the screen until the rectangle pulses. Lock appears on the
screen, and the exposure remains locked until you tap the screen again.

To Trim a video: While viewing a video, tap the screen to display the controls. Drag either end
of the frame viewer at the top of the video, then tap Trim. If you choose Trim Original, the
trimmed frames are deleted from the original video. If you choose “Save as New Clip,” a new
video clip is saved in your Camera Roll album, leaving the original video unchanged.

To take a screen snapshot: Press and release the Sleep/Wake button and the Home button
at the same time. The screenshot is added to your Camera Roll album.

Restarting and resetting iPad

If something isn’t working right, try restarting iPad, forcing an app to close, or resetting iPad. If
you can’t turn off iPad or if the problem continues, you may need to reset iPad.

To restart iPad: Hold down the Sleep/Wake button until the red slider appears. Slide your finger
across the slider to turn off iPad. To turn iPad back on, hold down the Sleep/Wake until the Apple
logo appears.

To Force an app to close: Hold down the Sleep/Wake button on top of iPad for a few seconds
until a red slider appears, then hold down the Home button until the app closes.

To Reset iPad: Hold down the Sleep/Wake button and the Home button at the same time for at
least ten seconds, until the Apple logo appears.
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iPad Apps:

My Story gives children a way to share stories by creating a recorded storybook on the
iPad. Draw, write, and record your stories with an easy-to-use interface for all ages.

PuppetPal and PuppetPal HD: Perfect for digital storytelling projects, PuppetPal allows the
student to choose characters (including photos of themselves) and backgrounds, drag them onto a
stage, and add animations and voice recordings. Create your own unique shows with animation
and audio in real time. Export the movie and upload to a YouTube channel to share the video
with the students in the class. This is a free App but you can buy the director's pass for $2.99 and
receive all content.

The Fantastic Flying Books of Mr. Morris Lessmore has been regarded by many as the most
creative use of the iPad. Morris Lessmore hit the number one spot on Apple's iPad app chart,
becoming not just the bestselling book but the bestselling App of any kind. It has been called
"the best," "visually stunning," and "beautiful" in a NY TImes review and "the most stunning
iPad app so far" according to MSNBC. The Times UK predicted that "The Fantastic Flying
Books of Mr. Morris Lessmore will be regarded as one of the most influential titles of the early
21st century." It is a children's story inspired by Hurricane Katrina, Buster Keaton, The Wizard
of Oz, and a love for books. The text can be changed to French or Spanish.

Explain Everything is an easy-to-use App that lets you annotate, animate, and narrate
explanations and presentations. Create interactive lessons, activities, assessments, and tutorials
with Explain Everything. You can even use Explain Everything as an interactive whiteboard.
Explain Everything will record on-screen drawing, annotation, object movement and captures
audio via the iPad microphone. You can import photos, PDF, PPT, and Keynote files and then
export the final product as as a movie file to share.

VoiceThread: Now you can use, create, and share your VoiceThreads directly on the iPad.
Create conversations with your students around documents, snapshots, diagrams, and videos.
You can talk, type, and draw directly on the screen. You can share your VoiceThread with your
students and they can join the discussion from their iPhone, iPad, iPod touch, Mac or PC. Add
images from your iPad camera or photo library, flip through pages and annotate them while you
narrate, and then simply share with your students.

Skitch: Annotate, edit, crop and share images and screen captures. Skitch is great for the flipped
classroom, creating tutorials and highlighting specific aspects of an image. It works great with
Evernote.
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Flipboard is a free App that was named Apple's iPad App of the Year and one of TIME's top 50
innovations of 2010. Flipboard is a fast, and visually beautiful way to flip through news, photos,
videos, from many news sites, as well as content from your Google Reader, Facebook, Twitter,
and Flickr accounts. View your media in a magazine layout that is easy to scan.You can
subscribe to popular publications like National Geographic, The New Yorker, Wired, and Rolling
Stone, or customize your Flipboard with sections created from your favorite news, people, blogs,
and topics.

The Waste Land App brings alive the most revolutionary poem of the last hundred years with a
21st century tool displaying a wealth of interactive features that illuminate T. S. Eliot's greatest
work. This digital edition respects the integrity of the original yet offers spectacular new ways to
explore the significance and influence of the poem. Watch and listen to performances and
readings of the entire poem, synchronized to the text. You can even listen to an original recording
by T. S. Eliot himself. Understand the poem's many references and allusions with interactive
notes and examine original manuscript pages to see how the poem took shape. This iPad app
carries forward Eliot's vision and vividly demonstrates how literature can be illuminated by the
new digital medium.

7 Billion: How your world will change coincides with the arrival of the the human population
reaching 7 billion people. The app explores the challenges of a growing human population in a
world of limited resources and explains the demographic trends that got us here today and how it
will impact us tomorrow with informative videos, interactive maps, in-depth articles, and
stunning photography.

Touch Physics HD, an iPad game designed for both children and adults, young scientists and AP
Physics students, takes on the world of physics Draw shapes with crayons in order to complete
each level with the goal being to move a wheel to a target space. You achieve this goal by
creating shapes that interact with the wheel.

MathBoard is an app for teaching addition, subtraction, multiplication and division.
Customizing the problems will make MathBoard appropriate for all ages from kindergarten, with
simple addition and subtraction problems, to elementary school, with multiplication and division.
You can control the range of numbers and the amount of questions. You can even assign a time
limit per quiz. Students have a workspace to complete and show their work and then answer the
multiple choice questions or see step-by-step problem solving to help them generate the correct
answers.

TouchCast, a video creation tool, lets students and teachers create and watch videos that are
layered with live Web pages, YouTube clips, Twitter streams, and google maps that viewers can
expand, manipulate and turn on and off. Create a newscast with picture-in-picture for the flipped
classroom and tutorials. This app is free and fantastic.
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Art Set allows everyone to create original art with a variety of virtual "papers," paints, crayons,
pens, pencils, pastels, markers, and texturing and blending tools. Additionally, Art Set allows the
artist to paint over photos stored on the iPad. It is fun even for the non-artist. This one is good for
younger artists.

The iTunes U app gives you access to complete courses as well as the world’s largest digital
catalog of free education content. Take free courses created by instructors from leading
universities and other schools. See all of the assignments and updates from the instructor in one
place, and check off assignments as you complete them. Take notes and highlight text in iBooks
and see them consolidated for easy reviewing in the iTunes U app. Access course materials,
including audio, video, books, documents & presentations, apps, and new iBooks textbooks for
iPad.

iStopMotion allows the use to Enjoy the excitement of creating stop motion animations, also
called claymation or stop action movies, as well as time lapse recordings. Use this app for digital
storytelling to bring your characters to life frame by frame. Each movie can contain hundreds of
frames. You can share the videos directly to YouTube or continue to edit in iMovie.

GoClass works very well in a 1:1 learning environment for all levels. With GoClass, you can
create lessons and deliver them to your students. Include annotated images, sketches, text, and
video in the lessons. Create class rosters so that you can keep track of the usage of the lessons by
the students. Post questions and poll your students. Once the students responses are gathered,
you can project the responses without showing student's names. The polling becomes a terrific
way to prompt discussions about the questions and materials that you have presented to your
students.

TinyTap is designed for young students but can be used by older students and teachers of older
students, as well. Create an online quiz, story or interactive book with voice recordings and
music. Add photos, take a picture, record a narration. TinyTap can be used for world language
classes, math, art, and much more. This is a prime example of using a basic app in a number of
creative ways.

Rover is a web browser app that works well with Google Docs and with Flash-based websites. It
provides links to educational resources but it can just be used as a web browser that can, on
occasion, work better than Safari.

ShowMe allows young students and older students the ability to create, annotate and record over
one slide. Show Me can be used for a digital storytelling project, for creating a tutorial for the
flipped classroom or for an animated demonstration or explanation of a topic. Slides are saved to
their website, allowing for easy access. Screenchomp and Educreations are similar apps. in
ShowMe, the file is no longer editable once you have recorded your narration.

Comic Life, an iPad version of the Mac app, allows the student to use photos from the Camera
Roll or take photos to place in a wide variety of comic strip templates. Students can add text
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bubbles, format fonts, and play with a variety of styles. Final products can be sent to the the
Photo Library or shared via email.

Toontastic is another comic strip creator, but this one guides the student through the process
with the setup, conflict, challenge, climax, and resolution of the story arc. Students can draw
their own background or use one of the templates. Then they add characters or draw their own.
They can then animate each scene, record a narration, and add music, making this site useful for
both young learners and learners of world languages.

Sonicpics allows you to add pictures or take a picture and then record a narration of your
slideshow, great for explaining a lab experiment, documenting a field trip, analyzing plant
growth, or creating a tone poem.

Composer is another sophisticated book creation app, allowing you and your students to create
interactive, animated ebooks. You can add sound, movies, special effects, and animations.
Composer has a steeper learning curve than other apps, but the product can be quite polished.

ifPoems provides audio narration of over 200 well-known poems, but the coolest feature is the
ability to record one’s own oral interpretation of the poems.

Inspire Pro, ArtRage, procreate, Brushes are all painting apps, each one with a different style
and focus. Art teachers should experiment with them all.

SketchExplorer, based on Geometer’s Sketchpad, provides the ability to drag, manipulate and
animate mathematics. This app does not allow for the creation of these animations, but it does
provide access to a gallery of animations to explore. This can be used for all grade levels of math
exploration.

Evernote is a note-taking and voice recording app that synchs with the free app that can be
downloaded to an iPad, iPhone, Mac, or PC. Evernote works really well as a digital portfolio for
all age students and for an assessment portfolio for teachers to share with parents and to aid in
grading and commenting on student work. Evernote also synchs with Skitch, adding to its
versatility and utility.

Showbie allows a teacher to assign, collect, and review student work because it is a cloud
storage solution designed to enable students to drop work from apps right into an online
assignment folder. Create an account on the Showbie website and then set up your class.
Through the website or app, students can share files quickly and easily, express their creativity
through creating content in apps for assignments, and hand in their homework using their mobile
device.

Creative Book Builder can create a multimedia book with videos, images, hyperlinks, music,
multiple choice quizzes, and voice recording. CBB allows you and your students to record videos
or insert one from YouTube. CBB can convert Google Drive documents into book chapters.
Books are then easily exported to DropBox, Google Drive, and iBooks.
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Leo’s Pad, a great educational app, is aimed at pre-schoolers and early learners. Produced by
Kidaptive-- a media and technology company dedicated to creative storytelling and developed in
collaboration with Stanford University--the app offers several interactive adventures. Children
design and build a rocket with Leo(nardo da Vinci), Gally (Galileo Galilei), and Marie (Curie) by
tracing and sorting rocket parts, mixing rocket fuel, and guiding the rocket through space. As a
child completes activities, the app will measure the user’s responses, automatically increasing or
decreasing in difficulty to create the optimal learning level for each user.

iBrainstorm is a collaborative brainstorming application for the iPad and the iPhone. Record
brainstorming sessions using a combination of free hand drawings and sticky notes placed on a
canvas that can be shared with other users of the app. The combination of sticky notes and free
hand drawing can appeal to different learning styles. While students can use the app on an
individual basis for planning, projecting the app and seeing students collaborate can be a great
educational tool. Free

Adobe Voice, a storytelling app, offers some interesting and educationally sound features. The
app provides templates like Explain Something, Follow a Hero’s Journey, Promote and Idea, or
Tell What Happened to inspire reluctant storytellers. Those who want to jump right in can choose
to make up their own. As with all other apps, this app allows the user to add text, images and
narrations. The unique feature is a built-in library of over 25,000 photos and clip art, so students
do not have to search the web to find appropriate images. Free

Knovio is a PowerPoint add-on app. Use the microphone and camera to add audio and video
commentary and narration to PowerPoint presentations. Upload the presentation to Dropbox or
Google Drive or email it and then open in Knovio. Commentary can be re-recorded.
Presentations are stored at a Knovia account and then shared through a link which can be viewed
on a browser on either an iPad or a laptop with no app needed for the viewing. Free

IFTT allows the creation of the recipe "If This, Then That" to automate your web activities.
Channels are the basic building blocks of IFTTT. Each channel has its own Triggers and Actions.
The "This" part of a Recipe is a Trigger; some example Triggers are “I’m tagged in a photo on
Facebook™ or “I checked in on Foursquare.” The "That" part of a Recipe is an Action; some
example Actions are “send me a text message” or “create a status message on Facebook." A
Recipe might autosave all your Instagram photos into your Dropbox. It sounds complicated, but
with a little practice, you can make your life on the internet more efficient.

StopMo Studio, easy-to-use but also quite powerful, creates stop motion animation videos. To
get started, all you have to do is set up the scene and begin taking pictures. Then: Move, Stop,
Picture, Move, Stop, Picture. Repeat until you have completed your entire film. You can
rearrange, delete, or add shots along the way. Also, you can add music from iTunes or a
recording to any or all of the four audio timelines. The Extras panel includes the ability to add
photos, sound effects, titles, solid colors, and annotations. Cost is .99%

Stick Around allows the user to create a variety of assessment puzzles, including venn diagrams,
matching and sorting activities, and labeling. Add an image, create "stickers" that are text only,
text and image, or image only and then drag the images to the correct locations to create an
answer key. Use drawing tools or photos to create the background. Record audio instructions. A
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terrific feature is the ability to Import screencasts from Explain Everything to use as instructions,
and puzzles can be exported to Explain Everything to add recordings and annotations. Some
suggested uses for this app from the website: place locations on a map, tag parts of the body,
place items where they belong on a chart, complete a graphic organizer, annotate the water cycle,
label people in a photo, diagram a sentence, associate powers with the branches of government,
sequence events on a timeline, associate words and definitions, label the parts of a plant, put
words in alphabetical order, fill in a Venn diagram, and match photos of animals to their habitats.
One negative is that students must have the app to play the puzzles. The cost is $2.99.

Notability, considered one of the best note taking apps, allows the user to markup PDFs (useful
for grading essays), and now everything you type, write or add to a note is linked to an audio
recording. Just tap play and watch your note unfold. You can jump to a specific point in the
recording by tapping a word with the navigation tool. This visually rich presentation provides an
interesting way to review notes or to create lessons or instructional material.

YAKit and YAKit Kids create talking images by adding an animated mouth, eyes, noses and
more. Record a narration and play with the pitch of the voice. YAKit Kids limits the sharing
environment. This is a great app for digital storytelling projects. Add a series of animated photos
to create a video slideshow. Export to the camera roll and then edit in iMovie or add to a book
creator app or to a screencasting app to jazz up a flipped classroom presentation. Free for both
iPhone and iPad.

Subtext, also available at Subtext.com, is a collaborative reading app. After creating an account,
the teacher searches for an eBook, web article, or PDF document to add to a group. The teacher
then populates the reading with discussion and multiple choice questions for formative
assessments. After joining the group, a student has the opportunity to discuss the reading with
other students in the class. Another useful feature is the ability to add videos and images to help
students visualize the text. FREE but some of the books do need to be purchased.

Literacy Leveler makes it easy to find books of an appropriate reading level. Scan a book's
ISBN with the camera on an iPad or iPhone to see its Guided Reading Level, or you can search
for a book by title, author, or level. You can then add the book to a personal library. The
database focuses on grades K through 8.

Ken Burns App is essentially a curated mixtape of Ken Burns’ films. Short clips from his
documentaries are broken down into hour-long playlists and grouped by themes: Art, Hard
Times, Innovation, Politics, Race, and War. Each playlist is comprised of 10 to 20 scenes that run
under three minutes each. The Timeline view explores a chronological history of America
through his films. The preview version of this app is free, but it features only the “Innovation”
playlist. Accessing all the content costs $9.99

News-0-Matic, a daily newspaper for young learners, goes beyond just the news by adding
videos, images, maps, suggested activities, and a read-to-me option. Five new articles appear
daily, but there is also an interactive history-based timeline, puzzles, games, and audio support
for challenging vocabulary words. Free but annual subscriptions are recommended.

Swiftkey improves the typing experience on an iPad or iPhone (or Android phone) by suggesting
word choices that are tailored to your writing style and by "next-word predictors." Swiftkey

Chapter 5 « 1Pad Tips, Tricks, & Apps * page 95



connects to Evernote to significantly enhance note-taking. The more you use it, the better it
becomes with more accurate next-word choices. SwiftKey supports typing in English, Spanish,
French, German and Italian. Free

Popograph allows you to lift a part of a photograph to add a 3-D effect to that section. Then add
filters, captions and text, shading and a variety of frames to create a unique work of art.

Stack the Countries is the newest app from the developers of Stack the States. Both apps
present games for the study of landmarks, capitals, major cities, borders, etc. Stack the Countries
can be played in English, French or Spanish. Student can play a variety of games and study with
the supplied flashcards.

MusiXmatch (also available for iPhone, Android, or Mac) can identify millions of songs and
obtain their lyrics. You can search lyrics based on a few words, watch music videos and concerts
from YouTube, and find music titles, artists and discography information for songs. Free

Thinglink is both an app and a website that allows the user to add hot spots to any image. The
hotspots can be links to web sites, youtube videos, and text annotations. The app adds the ability
to record with the camera, so students can create their own video explanations about the image or
use the camera to add their own pictures. Thinglink can be used in all grade levels and for all
subjects.

Scanner Pro turns your iPad and iPhone into portable scanners, so you can scan receipts,
whiteboards, paper notes, or any multipage document. Scanned documents can be emailed,
uploaded to Dropbox, Google Drive and Evernote, or saved on the iPhone/iPad. The application
incorporates special algorithms that remove shadows, make scans sharper, and correct
perspective.

Inspiration, the old favorite, is now an iPad app. Use Inspiration Maps to brainstorm, plan,
organize and build thinking skills. Turn a diagram into an outline that can then be exported to a
writing app. App includes a searchable symbol library with over 1500 images, the ability to add
images from the web or the iPad camera, dozens of templates including some in French and
Spanish, the ability to add written or audio instructions, and the ability to attach audio to a
symbol. The drag and drop of the iPad makes this version of Inspiration particularly user-
friendly. The downside is the price $9.99, but it can be purchased at a discount. Inspiration Maps
Lite is free, so it serves as a good starting point.

Cloud Art creates word clouds by entering text into the app, pasting from a document, or
entering the URL of a website. Customize the word cloud with a variety of color schemes, fonts,
font layouts, and backgrounds. Tap on an individual word to make it larger or smaller. The
finished product can be emailed or saved to the camera roll to be used in another app. Analyze a
famous speech, a poem, a chapter from a textbook, or an article from the web by looking at
words used and word frequency.

Chatterpix Kids, similar to YAKit, creates talking photos.Take a picture of an object, a photo, a

living creature, or access the built-in gallery to create a talking image. Draw a line to create a
mouth, record a narration, add special effects and props, and save your animated creation. This

Chapter 5 « 1Pad Tips, Tricks, & Apps * page 96



app can be used both for recreation and for education. Another app, Chatterpix, allows uploads to
social media. Free

Kodable offers a kid-friendly introduction to programming concepts and problem solving for
children ages 5 and up. With a series of directional arrow commands, children lead fuzz balls
through Kodable’s 90 levels of increasing difficulty. The first 30 levels are free; each additional
set of 30 levels are a $1.99 add-on. Each level aims to teach children to think like a programmer
to solve problems. As they navigate through the levels, children utilize functions, conditional
statements, if/then statements and loops without even knowing it.

Futaba turns your iPad into a small smart table with this classroom game for up to four players.
Futaba, a multiplayer game designed for K-6 classrooms, supports many types of learning
activities. The app contains a number of learning sets, including sight words, subtraction,
multiplication, telling the time, currency, countries and flags, but teachers can build their own
game content to support any curriculum. Students match answers to text or image based
questions and compete against up to 3 other students.

Nearpod allows teachers to create multimedia presentations and then share them with their
students while controlling their students' activity on the iPad. Students submit responses on their
iPads while teachers can monitor classroom activity and evaluate student understanding of the
material. Teachers can push information, questions, websites, and activities to their students in
real-time. Teachers download the teacher app, while students use the student app. Free and
Premium versions available.

Playback allows the user to create screencasts for tutorials and the flipped classroom. Its
distinction is the ability to use the iPad camera to add your face to your screencast videos. There
are two modes, picture in picture and full-screen. Dropbox uploads are now fully integrated so
files can be uploaded to Dropbox even if the Dropbox app is not installed. You can sketch and
type on a virtual whiteboard or over your presentation slides. Playback will record your
annotations along with audio commentary to produce a movie you can share. Import your slides
in PDF format to playback then use the tools to help you explain your slides. The tools include
handwriting, eraser, audio commentary, pan and zoom, laser pointer and typed text. Free

9Slides, a slideshow creator app, allows users to add video or audio commentary to a
presentation slides directly on an iPad. Import PowerPoints, pdfs from SlideShare, Google Drive,
or Dropbox, and record video within the presentation. The final product can be published online
for students.

Felt Board, a storytelling and more app, allows the student or teacher to design scenes, dress up
characters and create math and tangram puzzles. Add to characters by selecting hair and facial
features. Choose from a wide variety of costumes, settings and props for digital storytelling,
literacy with numbers and letters, and word recognition. Felt Board includes a gallery to save and
edit Felt Board designs.

Story Wheel allows 1-4 players can create a story. Start by spinning the wheel to get a picture.

Next, each student records her voice as she develops a story with that picture. Each player will
build upon the story with a new picture. Creations can be shared online or emailed.
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iPad Program Considerations

* Revising the AUP: Consider use of iTunes accounts and apps, camera and video regulations,
game playing, video watching, audio recording of classes, peers, and teachers, jailbreaking, app
installation, iCloud and backups, insurance, carrying and storing, charging, security, AppleTV
and projecting iPads.

* Deployment and Management: app purchases and distribution, device ownership, apps
ownership, iTunes accounts and students younger than 13, updates, maintenance, 1:1 vs. carts,
appropriate ratio of iPads to students as suggested by grade level, time frame, best practices,
identifying sound educational apps, strategies for classroom management, strategies for faculty
evaluation of apps as an ongoing process, strength of network (particularly with use of Apple
TV), iPad memory issues particularly with the advent of etextbooks, faculty professional
development, keyboards and accessories, printing, strategies for app requests, evaluating
etextbooks, use of iTunes U, workshops for parents.

* Costs to consider: iPad model, case, insurance, apps, accessories (including keyboard and
stylus), infrastructure upgrade, Apple TVs and televisions, stipends to faculty for creating iPad
rich courses and iPad rich textbooks and course content, extra chargers, charging stations, extra
iPads as loaners, iPads for faculty, iTunes gift cards for faculty, HDMI projectors.

*Kinds of Apps needed: voice recording, PDF annotation, Whiteboard and Shared Whiteboard,
Annotated drawings, Photo Editing, Video Editing, Stop Motion Videos, Presentation,
Mindmapping, Note Taking, Essay Writing, Drill and Skill, Simulations, Screen Capture,
Geography, animated textbooks and books, Storytelling and story creation, Painting, variety of
browsers, Math and Science manipulatives, Book reading, Aggregators.

» Starter List of Apps: Garageband, iMovie, Keynote, Pages, Comic Life, Explain Everything,
Educreations, Google Earth, PuppetPals, Kindle, iTunes U, Book Creator or My Story, Rover,
Evernote, Skitch, Voicethread, Skype, iStop Motion, Notability, Touchcast, Tiny Tap, Adobe
Voice.

* Rethinking Curriculum: differentiated learning, Multimedia creation, always-on access to web,
always- on access to camera, video and voice recording, learning spaces shift away from labs,
expertise shift towards students, strategizing essay writing, constructing alternate assessments,
teacher and student-created textbooks, anthologies, class notes, lab reports, etc.
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1Books Author Tutorial

Creating your eBook

The bulk of your text should be created prior to using iBooks Author, which should be
considered primarily a layout program and not a text editing program. You can, of course, add
and edit titles and captions, and the text itself, but your life will be much easier if you do the
writing in either MS Word or Pages. Organization is the key; put chapters in folders on your
desktop, ditto with images and videos. Images in folders can be dragged easily to create a
slideshow. Keynote presentations can be dragged into a widget, so download all Google Docs
presentations and create as Keynotes, ditto for all your PowerPoint presentations.

First, download iBooks Author from the Mac app store. This free download is not available for
the PC, so some PC schools are purchasing a few Mac laptops or desktops to aid in the process
of ebook creation. Students can construct their share of the book on a PC, and then all the pages
can be merged in Word on a Mac and then imported in to iBooks Author.

Step One: Choose your template. Don’t be concerned about the name or subject matter of each
template; the text is entered as placeholders.
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Step Two: Begin to customize the template by clicking on the on the options available on the left
hand sidebar. First, enter your book title by double-clicking within the title place holder text box.
You can format the text by using the usual text-editing toolbar that runs across the top.

Step Three: Change the book cover photo by dragging and dropping the desired image file onto
the photo place holder. If the photo does not fit into the dedicated area, drag the slider in the

(" Edit Mask )

“Edit Mask” box until the image is resized to fit. If you would like an introductory video, then
click on “Intro Media: and drag and drop your fit into the video place holder. Please note that
videos must be in .m4v format. Adding video to your iBook is also really easy; however, you
need to have the video in the right format. You can drag and drop your video into the iBook and
then edit the videos size and location within the book. If you get an error when you try and drop
the video into the book then that means the format is not correct. You can change the video to the
right format by opening the video up in Quicktime and then exporting the video to a format that
works on iPhones and iPads.

Step Four: Create your chapters. Delete the template chapters on the left toolbar, and Choose
Insert > Chapter from Pages or Word document. Choose the document to import, and click
Insert. The style sheet from your Pages or Word document is also imported. Choose the desired
layout. Once you have your text in the template you can adjust the formatting, add hyperlinks,
and much more. Instead of accessing the Insert Menu, you can simply drag a Pages or Word
document into the Book pane from the Finder. If you are trying to produce something really
simple with no chapters, set the first chapter as a preface by clicking the pop-up menu by the
page thumbnail. Then your ebook won't start with Chapter 1 on the iPad.

Step Five: Edit your text.

* Make sure you have given each title a name so that it shows up correctly in the table of
contents. You can do this by selecting the chapter on the left hand column. Right click
where is says chapter to the right and then select rename. Rename the chapter to
whatever you would like.

* You need to make sure that the book looks right from both orientations. At the top of the
page you will see a small icon that says orientation. Click on each and view the book to

[=NaT Y

View Orientation

=l | ometel 1]

make sure that everything looks right from both view points.
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Step Six: Plug your iPad into your computer and choose the preview option at the top. It’s
always best to preview your book on an iPad to make sure everything looks and interacts the way
that you desire. If your layout is only good in landscape, you can disable portrait entirely by
checking the box in the Document Inspector (Document tab).

Step Seven: Get Interactive. Click on the Widgets icon on the toolbar.
Untitled

1 @& (.

ext Box Shapes Table Charts

Choose one of the widgets. The media files can be resized, dragged and dropped into different
locations on the page, and cropped to fit your needs.

fag in a movie or audio file

Drag an image from Finder
or a folder of images

Gallery Media

complete with animations
and fransitions

Draiin a Keynote presentation

@ Lorem

Add a sequence of multiple-choice o Ipsum
or drag-to-target questions
@ Dolor

\ Review Keynote

Use labels, panning, and zooming to provide
information about specific parts of a graphic.
' readefs can rotate

N €.

Interactive Image 3D

Drag if a 3D COLLADA (.dae) file

Add an HTML Dashboard widget file
(with the file extension .wdgt) created with

< a > Dashcode or any other HTML editor that can
create Dashboard widget files (an advanced feature)
HTML

Step Eight: Publish your final product. Now that you have created your iBook, it’s time to
export it so it can be published. First you need to export your publication. Click on File and
choose export. Then choose iBooks from the menu. Give the iBooks file a name, choose a place
to save it, and click export.
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Displaying the iPad Screen

Teachers really want to the ability to display their iPad or their students' iPads on a projector
screen. Projecting on a large screen is great for demonstrations, simulations, explanations, and
showing examples. There are several ways this can be done in the classroom.

VGA Adaptor: If you do not need to move around the classroom or display student iPads, then
the VGA dongle is the most straightforward connector. Plug in the iPad as you would your
laptop. This method is cumbersome when walking around a classroom with a long cable attached
to the iPad and the adapter and cable add weight. Allowing students to display their iPads
requires disconnecting the dongle from one iPad and then re-connecting to another, creating a
certain lack of spontaneity.

Document camera (or USB camera): Again, if you do not need to move around the classroom,
then you can place your iPad in the document camera device, and project from the camera. One
advantage is that all apps will work as they are displayed and with some finagling, students can
display their iPad work.

If you want to wirelessly transmit your device's screen and audio so that you or your students can
walk around the room, then it gets more complicated. Apple's AirPlay feature, built into all iPad
2s and newer, works over Wi-Fi so you can roam around the classroom with your iPad in hand.
Any of the wireless options requires all devices to be on the same network.

Apple TV: Designed primarily for home use to connect to an HDMI television, the Apple TV can
connect to a projector. iPad can mirror wirelessly to Apple TV using AirPlay. The caveats: Apple
TV outputs HDMI only, so the school’s projector should have HDMI input; if the classroom has
an older projector, chances are that it will not have the necessary HDMI input. If that's the case,
then the additional need is for an HDMI to VGA adapter like the Kanex ATVPRO.

Connecting to a laptop or computer: Software is available to turn a Mac or Windows PC into an
AirPlay receiver. Download AirServer or Reflector (formerly named Reflection). The software,
installed on your computer, allows the iPad to be mirrored on the computer screen. Since the
computer is connected to a projector, the iPad screen shows on the projector. The advantage of
this method is that school’s do not have to purchase Apple TV’s or adaptors, while teachers can
still roam wirelessly and multiple students can access the Mac or PC to display their iPads for the
class to view. Not all apps will work flawlessly with this set-up, so you will need to experiment.
Both apps offer free trial downloads.

One major concern is the havoc the wireless methods can create. Apple TV, AirServer, and
Reflector do not always work well because AirPlay requires the device and the computer or
Apple TV to be on the same network. Often schools have different networks for mobile devices
and for PCs so AirPlay won't work. Also, AirPlay requires specific ports to be open on the
network and frequently they are not. By using these devices, the school is adding countless new
wireless transmitters to its network, causing bandwidth and connection issues. Also, by
installing AirServer on machines, some schools would have to restructure their VLANSs, not
always an easy task. Sadly, none of the options is perfect.
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http://www.amazon.com/dp/B002UBPBTC/ref=as_li_ss_til?tag=learninginhan-20&camp=0&creative=0&linkCode=as4&creativeASIN=B002UBPBTC&adid=1A9TM9JVFKPPGVFGQ67Z
http://www.apple.com/airplay/
http://www.amazon.com/s/?_encoding=UTF8&camp=1789&creative=390957&field-keywords=Apple%20tv&linkCode=ur2&tag=learninginhan-20&url=search-alias%3Daps
http://www.amazon.com/dp/B0082AFROO/ref=as_li_ss_til?tag=learninginhan-20&camp=0&creative=0&linkCode=as4&creativeASIN=B0082AFROO&adid=11SHQNT7FJVFSHC1A17S
http://www.airserverapp.com/en/Download#
https://www.reflectorapp.com/
http://bowersandwilkins.custhelp.com/app/answers/detail/a_id/55/%7E/firewall-ports-utilised-by-airplay

